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C H A P T E R  1  

About SiteBuilder 

SiteBuilder provides unique capabilities for non-technical users who want to create, publish, and 
maintain their web sites without any knowledge of HTML or other programming languages. 
The SiteBuilder web site content management solution allows wide groups of users to create 
their web sites with minimum efforts.  

The SiteBuilder’s main benefits for users are the following: 

 Easy-to-use web interface implemented as a five-step point-and-click wizard allows end-
users to build and publish their web sites following a simple straightforward scenario. 

 More than 500 high-quality templates with color variants offer rich opportunities for users 
to make their web sites attractive and effective. 

 With the powerful 'What You See Is What You Get' Editor (WYSIWYG Editor) that comes 
with SiteBuilder, users see the entire page context while editing the contents. All changes on 
web pages can be tried and viewed before they are submitted, in the live context.  

 Ten SiteBuilder modules add more functionality to your web site pages, such as counters, 
bloggers, forums, guest books, and many others. Non-technical users can create specialized 
service pages, such as e-shops and photo galleries. 

In This Chapter 
Understanding SiteBuilder's Concept ................................................................................... 6 
Main Steps to Create a Web Site .......................................................................................... 6 
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Understanding SiteBuilder's Concept 
There are three types of users in SiteBuilder: Administrator, Resellers, and Users. The 
administrator and resellers work through the SiteBuilder administrator's panel, whereas users 
create web sites using the SiteBuilder wizard, which is a client part of the application. 

The SiteBuilder administrator is a user with administrator privileges who manages the 
SiteBuilder functionality and configures SiteBuilder settings for users. Through the 
administrator's panel, the SiteBuilder administrator can perform a variety of management tasks, 
such as configure system parameters (database settings, language, licensing, and backup 
options), set up publishing options, manage web sites, and define the components that will be 
available for users. The administrator also adds and manages reseller accounts (adds allowed 
hosts and web sites to reseller accounts). For more information about the administrator's 
functionality, refer to the SiteBuilder Administrator's Guide. 

Resellers are SiteBuilder subadministrators who can sell web-site construction services to end-
users. The resellers manage the web sites of their customers, define plans for web site 
construction services, and define the hosts on which users can publish their web sites. Resellers 
have their accounts (login and password) for logging into the administrator's panel. The 
SiteBuilder administrator adds reseller accounts to the administrator's panel. For more 
information on resellers and their functionality, refer to the SiteBuilder Administrator's Guide.

Users are clients who want to create and update their web sites using the SiteBuilder wizard. To 
start working with the SiteBuilder wizard, users do not need special accounts. The next section 
briefly describes the general procedure of creating a web site using the wizard. 
 

Main Steps to Create a Web Site 
As a rule, the process of creating a web site includes three main stages: planning, 
implementation, and web site updating or maintenance. 

Planning: The first and most essential stage in any project is planning. Before starting with 
SiteBuilder, think about the purpose of your web site and its target audience. After this, decide 
where your web site will be stored, or, in Internet terminology, hosted. This stage is beyond the 
scope of this document. We assume that if you have access to SiteBuilder, you have all 
resources required for site hosting. Then, you should develop a detailed structure of your future 
web site and prepare its contents, including text information and graphics. The planning stage is 
extremely important because it eventually determines the usefulness of your web site. 

Implementation: The next stage is the implementation of your web site. The five-step SiteBuilder 
wizard takes your through the entire procedure of creating your web site, from initial design to 
publishing and maintenance. The following are the main steps required to create a web site 
using SiteBuilder:  

1 To create a web site for the first time, open the SiteBuilder wizard. You can start working 
with the wizard without user authorization (no login/password needed).  

2 Complete the first four wizard steps (select the design, create the site structure, add web site 
contents, and provide extra information for search engines).  
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3 Open the Publish tab. At this step you will see detailed instructions on how to access your 
new web site so that you can edit it. Your web site created using the SiteBuilder wizard is 
saved as a trial site in a temporary storage directory on the SiteBuilder server. On the 
Publish tab, you will see an automatically generated site identifier. Using this link to the trial 
site, which might look like 
http://site_identifier.sitebuilder.hosting_provider.com, you can 
later return to your web site, edit and publish it (about editing your web site, see the How to 
Edit Your Web Site (on page 56) chapter). We recommend that you change the site 
identifier to some name you can easily remember (click Change My Site Identity).  

4 After you purchase hosting services from your provider, you will be provided with a domain 
name. Tell the SiteBuilder administrator the domain name where your web site will be 
hosted. The SiteBuilder administrator will enter your domain name in the publish properties 
for your web site in the SiteBuilder administrator panel. After publication, your web site 
will be available on the Internet. 

5 Enter the link to your trial site in the address bar of the browser window. Your web site will 
open in the browser window. Click Edit at the top of the web site to launch the SiteBuilder 
wizard. Now you can either edit the content of your web site. After editing, click Publish 
web site. The updated content of your web site will be transferred to the server where your 
web site is hosted. After publication, your web site will be available on the Internet. 

Maintenance: When you complete the above steps, you web site becomes available for visitors. 
It is critical to keep your web site content fresh because this is a good way to show your attitude 
to customers and services. Therefore, always be sure that your site is updated on a regular basis.  

With SiteBuilder is is very easy to keep the content fresh. All you need to do is to log into the 
SiteBuilder using the site identifier and your password, edit the content, and click Publish. 
SiteBuilder will automatically transfer the updated content to your hosting location. 

In the chapters below you will find detailed instructions on what you should do at every stage of 
creating your web site. 
 

 



 8 
 

C H A P T E R  2  

Getting Started With SiteBuilder 

This section describes your first steps with the SiteBuilder wizard. 

In This Chapter 
SiteBuilder Interface Basics.................................................................................................. 8 
How to Get Help ................................................................................................................... 10 
Logging into SiteBuilder....................................................................................................... 10 
How to Start With SiteBuilder .............................................................................................. 11 
 
 

SiteBuilder Interface Basics 
Below we describe the interface elements you will encounter while using the SiteBuilder 
wizard.  

Each wizard's window consists of the following main elements: 

1 The logotype image is located in the top frame of the SiteBuilder wizard. The default 
logotype is a SiteBuilder image linked to the SWsoft official web site. This image can be 
customized by the SiteBuilder administrator. 

2 The top help string provides short instructions on the operations you can do on this page. 

3 Use the tabs in the top frame area to switch between wizard's steps. The tabs that are 
available for you at the current stage of creating a web site are shown as active. For 
example, you cannot open the Edit tab until you have not created the structure of web pages 
on the Pages tab.  

4 The work area displays interface options available for the tab selected in the top frame. 

5 Click the Help button to open HTML help topics. Find the information you need using the 
Contents and Index tabs. 

6 Use the Logout button to finish the current session with the SiteBuilder wizard.  

7 The help tips in the left frame provide detailed instructions on what you can do on the screen 
you are currently on. 

8 The command bar at the bottom of the window displays your last command. 

9 Use the Previous Step button to get to the previous step of the wizard (you can also return to 
another step by selecting the corresponding tab in the top frame area). 
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10 Use the Next Step button to switch to the next step of creating your web site (you can also 
click the next tab in the top frame area).  

 

Figure 1: SiteBuilder main window 
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How to Get Help 
SiteBuilder help system has been created to assist you in solving problems you might encounter 
when creating your web site. Finding answers on your own takes less time and is definitely 
more satisfying than any other way. To find the information you need, you can do the following: 

 Use on-screen context-sensitive help - is the easiest and quickest way to get instant help 
with your immediate tasks. Using context-sensitive help will not interrupt your workflow. 
The top help string contains short instructions on the operations that are available on the 
current page. If you need more information about available options, take a look at the help 
tips in the left frame. The command bar at the bottom of the screen displays the last 
command you have performed on the SiteBuilder page. 

 Read user documentation - click Help at the top of any SiteBuilder page to open the HTML 
version of User's Guide. Find the information you need using the Contents or Index tabs. If 
you prefer to read PDF documentation, download the files from the official SWsoft web site 
at http://www.sw-soft.com/en/products/sitebuilder/docs/ 

 FAQ - For the fastest way to solve problems, check out the SiteBuilder FAQ page 
(http://faq.sw-soft.com) that provides instant access to solutions for a variety of questions. 
Select the SiteBuilder category and view the list of FAQs related SiteBuilder. 

 Online forum. If you failed to solve your problem using the ready-to-use FAQs, join our 
online forum at http://forum.sw-soft.com/ Here, all users can post questions, exchange ideas, 
and troubleshoot common problems. However, this forum is an informal one. If you are 
seeking help from SWsoft technical professionals, please contact our technical support 
specialists.  

The SiteBuilder help system offers you a comprehensive collection of end-user documents and a 
variety of self-help solutions that will assist you in resolving problem-based questions. If you 
have any problems or questions that are not covered in the documents or online services, please 
contact SWsoft Technical Support. 
 

Logging into SiteBuilder 
To log into the SiteBuilder wizard for the first time and start creating your web site, you need no 
user login or password. As SiteBuilder has a web-based interface, you work with the application 
in a window of your browser. 

If you have access to the SiteBuilder service, the administrator should give you an entry point to 
SiteBuilder. For example, the link can be 
http://sitebuilder.hosting_provider_domain.com/sitelogin.php (this 
is only an example, real URLs can differ). Enter this URL into the address bar of your browser. 
The SiteBuilder wizard opens on the first Overview page. You can also access the SiteBuilder 
application from the web site of your hosting provider. 

Note: If you bought the SiteBuilder service as a part of Plesk hosting service, you can log in to 
the SiteBuilder application right from the Plesk control panel by clicking the SiteBuilder button 
in the Domains section of the client interface. 
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How to Start With SiteBuilder 
After you have logged in to the application, you can overview the SiteBuilder functionality and 
select language for its interface.  

 

Figure 2: Selecting the language. Overview page 

First, select a language of the wizard's interface from the Language of the application interface 
drop-down list. 

On the Overview page you can see an overview of the five steps of web site creation. These steps 
are: 

 Design - choosing the web site layout, color scheme, button style, a flash movie for the first 
page, etc. 

 Pages - creating the structure of your web site and adding new pages 
 Edit - editing the contents of web pages and inserting modules in the content 
 Extra - providing additional information, such as the keywords for your web site, its name 

and description necessary, which will be used by search engines and specifying your 
password to protect your web site from attempts of unauthorized users to edit it 

 Publish – transferring your web site to the specified hosting location 

To start creating your web site:  
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 click the Design tab at the top of the page 
OR 

 click the Design icon in the main work area 
OR 

 click the Next Step button in the lower right corner of the page 

Note: If you use SiteBuilder for the first time, only two tabs are available at the beginning: 
Overview and Design. If you have already done something and stopped at some stage, click this 
stage to continue editing your web site.  
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C H A P T E R  3  

Creating Your Web Site 

The following sections describe the steps you should follow in order to create a fully featured 
web site, starting from the web site design to gathering web site statistics.  

In This Chapter 
How to Create Design for Your Web Site............................................................................. 14 
How to Add Pages and Create Web Site Structure ............................................................... 16 
How to Edit Web Pages ........................................................................................................ 19 
Providing site info................................................................................................................. 49 
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How to Create Design for Your Web Site 
This section discusses how to choose a design for your future web site. Web site design consists 
of the following elements:  

 Layout is a general template for a web site. It defines how separate elements, such as a 
company logo, head banner and navigation buttons, are arranged on web pages. 

 Color scheme is web site colors including the header, footer, menus, font and body colors. 
Edit the web site color scheme to make your web site look more attractive and efficient. 

 Head banner is an image usually located at the top of a web site page. Choose a head banner 
from the set of images available in the wizard. You cannot use your own images as head 
banners. 

 Buttons are links used to navigate through web site pages. 
 Logotype is a text and a graphic image that identify a company or a product. The logotype is 

a key element in corporate branding. 
 Flash intro is a short flash movie played on the introductory page. Flash intro adds more 

visualization to your web site. 
 Info includes additional information about your company and the web site, such as the 

company name, copyright, URL to the corporate web site, and the slogan. 

All these elements can be customized on the Design tab using the buttons in the navigation pane.  

 

To create a design for the web site:

1 Click Layout in the navigation pane to select a layout for your web site. Click the Preview 
button under a layout to view its enlarged image. Click the Select Layout button or the 
layout image to select the layout. 
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SiteBuilder offers an extensive set of layouts so that you can select the one that best fits 
your needs. You can browse layouts by categories or may prefer to browse all available 
layouts. To browse layouts by category, select the desired category in the drop-down list at 
the bottom of the page. To view all available layouts, select All categories in this drop-down 
list. 

To preview your future web site, click the Preview web site button at the top of the 
navigation pane. In the preview mode, you can see how your web site (with current contents 
and settings) will look in a web browser window. 

2 Click Color Scheme in the navigation pane to define a color scheme for the selected layout. 
Click the Select Color button to apply the desired color scheme to the selected layout.  

3 Click Head Banner in the navigation pane to change the default head banner image. Select 
the image you liked most and click on it. To view an enlarged image, click Preview. 

4 Select Buttons in the navigation pane to customize the design of buttons used to navigate 
through web site pages. Select the button design you like most and click Select Button. 

5 To upload a logotype of your company to the web site, select Logotype in the navigation 
pane. In the Upload new logotype field enter the full path to the logo image file (a .gif or 
.jpeg file). The recommended size of the logo image depends on the template selected and is 
specified on the page. 

6 You can insert a short flash movie that will be played on the introductory web page. Click 
Flash Intro in the navigation pane. On the page that opens, select a flash movie from the 
right-hand pane.  

Check the Enable flash intro box to play the selected flash movie on the introductory page of 
your web site. In the fields below, enter the heading and body text for the selected flash 
movie. Select the color for the flash and objects used on the flash movie from the 
Background scheme and Object scheme drop-down lists. Click the Apply button in the lower 
right corner of the work area. 

7 To place the company name, slogan, URL, and copyright on your web site (all these 
elements are optional and depend on the template selected), click Info in the navigation 
pane. Provide the required information in the corresponding fields and click Apply. 

 

Figure 3: A company logotype 

After the general design is ready, you can move to the next step. Click the Next Step button or 
the Pages tab to define the structure and pages for your future web site.  
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How to Add Pages and Create Web Site 
Structure 

The next step is adding pages to the web site and organizing them in certain order. Click the 
Pages tab to add new pages and define their hierarchy. 

A web site consists of several pages linked together in an organized way to present information 
in an ordered way. Using SiteBuilder, you can arrange the pages in the two levels of hierarchy - 
top-level pages and second-level pages. Therefore, before this stage you must clearly understand 
how you intend to structure your web site.  

In this version of SiteBuilder, you can add three types of pages to your web site: 

 HTML pages that use only HTML code to present information. 
 Photo gallery provides a convenient way to store and organized your pictures on the web site 

(this type is optional; it depends on your business plan) 
 E-shop pages offer web site visitors an opportunity to purchase your products online (this 

type is optional, it depends on your business plan). 

Note: The maximum number of top-level and second-level pages you can create using 
SiteBuilder is 60 (6 top-level pages and 10 second-level pages). This is the limit of the 
SiteBuilder application. In addition, the total number of pages a user can add is also limited by 
the business plan defined either by the SiteBuilder administrator or a reseller. In the figure 
below, the maximum number of pages allowed by the business plan is 10 (see this message in 
the navigation pane on the Pages tab). If you want to add more pages than allowed by your plan, 
please contact the SiteBuilder administrator or reseller. 

To facilitate working with SiteBuilder, HTML pages are grouped as predefined sets of pages, 
which are different for various types of web sites (business, personal, or other). Depending on 
the purpose and functionality of your future web site, you can use a ready-to-use page set and 
modify it to adjust the structure of your web site to your needs.  
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Figure 4: Adding pages to the web site. Pages tab 

To add pages to the web site and organize them in a hierarchical structure: 

1 Select a type of your future web site from the Web site type drop-down list. A set of pages 
for the selected type appear in the list below.  

2 From the list, select the pages that you want to add to your web site using the corresponding 
check boxes.  

3 Click the Add selected page(s) button to add the selected pages to the web site structure.  

4 Edit the current structure of your web site using the buttons in the right part of the screen: 
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 To add a new page to the web site structure, click Add New Page. An additional screen 
appears (in the figure below this screen is gray). Select the type of the page (HTML 
page, Photogallery page, or Shop page) from the Type drop-down list and type the title 
for the new page in the Title field. 

 

Figure 5: Adding a new page 

 To edit a page title, select the page in the list, click Edit Page Title, and type the new 
name in the Title field. 

 To delete a page, select it in the list and click Delete Page(s). 
 To move a page up or down at the same level, click Move Page Up or Move Page Down, 

respectively.  

 To move a page from the second level to the top level, click Move Page to Upper Level.  
 To move a page from the top level to the second level in the structure, click Move page 

to Lower Level. Pages at the second level are marked with "..." before their titles. 

5 To preview the current version of your web site, click Preview web site in the top left corner 
of the window. Note that you can preview the web site at any stage of its creation. 

When you finish working with the web site structure, click the Edit tab. You will be asked to 
save changes to the web site structure. Click OK to move to the Edit tab.  
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How to Edit Web Pages 
The next step is filling your web site with the relevant content and organizing it on pages. Click 
the Edit tab to add and edit the content of your web pages. 

The SiteBuilder application is empowered with a user-friendly WYSIWYG content editor, 
which enables you to see the content on the display screen exactly as it will appear on the 
Internet. Using the SiteBuilder modules integrated with the editor, you can significantly extend 
the functionality of your HTML pages by adding counters, bloggers, forums, guest books, and 
many others. The sections below describe in detail how to add and edit the content of web 
pages. 

The SiteBuilder editor is organized in such a way that the information you type on pages and the 
design of pages are independent. Therefore, you can completely change the design for a page 
after you have typed a text on this page. You will not have to retype the information. 

 

Figure 6: SiteBuilder editor window 

The interface of the SiteBuilder editor is familiar to users who have had a previous experience 
with the Microsoft Office application bundle. The editor main window consists of the following 
parts: 

1 The SiteBuilder upper frame contains SiteBuilder controls, such as tabs, the Help button, and 
the Preview web site button. 
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2 The Editor toolbar provides access to commands used to edit textual information 

3 The Modules toolbar contains module icons used to insert modules on HTML pages. 

4 In the Editor work area, you add and edit the contents of your web site. Click the web site 
links to navigate to different pages. 

5 Using the Advanced button, you can view and edit the HTML structure of the part of text 
where your mouse cursor is on. 

6 The SiteBuilder lower frame displays the last performed command and contains buttons used 
to navigate between wizard's steps (Previous Step and Next Step). 

If the default size of the editor window is too small for you, click the  Full Screen button to 
enlarge the editor window to the full screen. To return to the smaller SiteBuilder screen, click 
the Normal Screen button. 

To save changes you have made while editing the content, click the  Save Changes button. 
 

Editing Textual Information on Web Pages 
The editor will open on the first page of your web site, for example, Home. To start working, 
place your mouse cursor on any place on this page and type the text. 

To navigate to another page on the web site in the editor window, simply click the 
corresponding button. For example, to edit the About Me page, click the About Me link in the 
editor window. 
 

Formatting Characters 

Using the SiteBuilder Editor, you can change the following properties: 

 Font 
 Size 
 Style 
 Color 
 Font Settings 
 Symbols 

 

Figure 7: Formatting toolbar 

To apply formatting to a text: 

1 Type your text. 
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2 Select the portion of the text you want to change (even one character will suffice). 

3 On the toolbar, click the icon corresponding to the property you want to change. 

Notes:  

 Use styles to apply a particular format to the selected text. This ensures that similar pieces 
of text are formatted in the same way, thus maintaining consistency throughout your web 
site.  

 To insert special symbols into the text, such as copyright character, letters of other 
alphabets, and other signs, click the Insert Symbol button on the Formatting toolbar. 

 

Formating Paragraphs 

Paragraph indentation and alignment are the main parameters that define the position of a 
paragraph on a page. Indentation determines the distance of the paragraph from the left margin 
of the page. You can either increase or decrease the indentation of the paragraph. Alignment 
determines the orientation of paragraph edges: left-aligned, center-aligned, right-aligned, or 
justified. In case of justified alignment, the text is spread evenly between the left and right 
margins of the page. Horizontal rules are used to visually separate the logical parts of textual 
information presented on the page. 

To apply formatting to a paragraph: 

1 Select the text which you want to format. 

2 Apply the following formatting commands: 

 To align the text, click  Justify Left,  Justify Center,  Justify Right, or  Full 
Justify on the toolbar. 

 To change the indentation of the selected text, click   Increase Indent or   
Decrease Indent on the toolbar. 

 To insert a horizontal rule, place a cursor in any place on the page and click the  
Horizontal rule button to insert the rule. 
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General Commands 

On the SiteBuilder's Editor toolbar, you can use the following commands to make changes to 
the text: 

 Click  Cut,  Copy, and  Paste to cut, copy or paste the text from the clipboard 

 Click  Undo to undo the last action and  Redo if you later decide you do not want to 
undo the last action. 

 Click  Find to open the Find and Replace dialog. In the Find What field, enter the text you 
want to search for. If you want to replace the found text,  enter the replacement text in the 
Replace With field. Click Find, Replace, or Replace All. 

 Click  Check Spelling to check spelling on the page (for English language). When the 
editor finds a possible spelling mistake, it opens a dialog box where you can make changes. 

 

Figure 8: Spell Checking dialog box 

 Click  Select All to select the entire text on the page. 
 

Inserting Images 

Using the SiteBuilder Editor, you can insert any images into web pages.  

To insert a picture: 

1 Click where you want to insert a picture. 
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2 On the toolbar, click  Insert/Modify Image to open the Insert/Modify Image dialog box: 

 

Figure 9: Inserting a picture 

3 You can insert a picture either from the site gallery or from the local computer. The site 
gallery contains images that are already used on your web pages. By default, the site gallery 
is empty. You have to upload files to the site gallery to be able to reuse them later on pages. 
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If the site gallery contains some pictures, click Select on the right from the Site Gallery field. 
You will see the Image Navigator dialog box that displays all pictures stored in the site 
gallery. Select a picture and click OK. 

 

Figure 10: Image Navigator 

To insert a picture from the local computer, click Browse... and navigate to the target  file on 
the hard disk. Click Upload to add the selected image to the site gallery.  

4 Choose the position and the border for the picture in the Layout group. From the Alignment 
drop-down list, select how the picture will be aligned on the page: left, right, atop of the 
text, etc. In the Border thickness field, enter the number of pixels for the border around the 
picture. The default value 0 means that the picture will be not bordered. 

5 Define the indentation of the picture, horizontal or vertical, using the fields in the Spacing 
group. Enter the number of pixels for indentation into the corresponding fields. 

6 In the Alternate text field, enter a short description of the picture that will be displayed for 
those users who are unable to view pictures in their browsers (if, for example, the Show 
pictures option is disabled in browser options). Instead of pictures, the respective alternate 
texts will be output. 

You can preview the image in the Preview box. 

7 Click OK to insert the picture. The picture appears on your page. 

To resize the picture, click on it on the web page. Small squares appear around its perimeter. 
Click on one of them and drag the mouse to resize the image.  

To move the picture to another location on the page, drag it to the new location and then release 
the mouse. 

To edit picture properties, double click on it to open the Insert/Modify Image dialog box where 
you can modify the above-described properties. 
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Inserting Links 

Using the SiteBuilder editor, you can insert both internal and external links. Internal links point 
to other places of your web site, taking the reader to related pages. External links pointing to 
other web sites are often used to improve your web site's popularity and increase your web site 
visitor traffic (the so-called Link Exchange).  

To insert a link: 

1 Click the  Insert Web Link button on the toolbar. The Insert/Modify Link dialog opens. 

 

Figure 11: Inserting a link 

2 To insert an external link pointing to another web site: 

 Enter the web site address (URL) in the URL field, for example, www.sw-soft.com.  

 In the Text field, enter the name for this link as it will be displayed on the page. 

3 To insert an internal link pointing to other pages of your web site: 

 From the To pages in this site drop-down list, select the page you want the link to point.  

 In the Title field below this drop-down box, enter the name for this link as it will be 
displayed on the page. 

4 In the Target drop-down list, define how the link will open: in a new browser window or in 
the same window. Usually, internal links open in the same browser window, whereas 
external links open in a new window. 

5 In the Text decoration drop-down list, select how the link will appear on the page: 
underlined, overlined, or with strikethrough formatting. If you select None, the link will not 
be distinguished from the context. As a rule, links are underlined. 

6 Click OK to insert the link. 

To edit an existing link, double-click it on the page. The Insert/Modify dialog box opens where 
you can change the above settings. 
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Working with Tables 
Tables are used to organize textual and numerical information in a convenient and clear way. 
They represent even large amounts of textual information in an easy-to-read format. Tables 
consist of grids formed by rows and columns. On web pages, tables are often used as a 
formatting tool to maintain the size and proportion of page borders in all browsers and output 
formats. Borders can be made invisible and information in a table appears as formatted in a 
desired way. For example, this can be useful when organizing the text in several columns, like 
in a newspaper. 
 

Inserting Tables 

To insert a table:

1 Place the cursor in the place where you want to insert a table. 

2 Click the  Insert/Modify Table button and the Insert/Modify Table dialog box appears. 

 

Figure 12: Inserting a table 

3 In the first two fields (Rows and Cols), enter the desired number of rows and columns for 
the new table.  

4 The Width field determines how much space the new table will occupy on the screen. Select 
the measurement unit (percent, pixels, or points) and enter the value in the Width field. 

5 In the Alignment drop-down list, select how the table will be aligned: to the left, center, or 
right of the web page.  

6 In the Border thickness field, enter the width of the table borders (in pixels). Enter 0 to make 
them invisible. 

7 In the Cell spacing field, enter the number of pixels to specify the space between the cells of 
the table. This value can be used to create margins within the text. 

8 In the Cell padding field, enter the number of pixels to set spacing between the boundary of 
the cell and the text inside the cell.  

9 Click OK.  

The new table appears on the web page. Click in a table cell to type the information. 
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Editing Table Properties 

You can edit table properties, such as border width, cell spacing, and the width of an existing 
table. 

To edit table properties: 

1 Double-click the table on the web page.  

2 In the Insert/Modify Table dialog box (see the figure above), change the layout, spacing, and 
width options for this table (the number of rows and columns cannot be changed).  

3 Click OK to save the changes. 
 

Adding Rows, Columns, and Cells 

After the table is inserted, the icons related to table formatting become active on the SiteBuilder 
editor's toolbar.  

 

Figure 13: Table Editing toolbar 

To add rows, columns, or cells to a table:

1 Place the cursor in the table where you want to add a new row or a column. 

2 Click the following icons on the editor toolbar: 

  or  to insert a row above or under the cursor, respectively 

  or  to insert a column to the left or to the right of the cursor, respectively 

  or  to add a cell above or under the cursor, respectively 
 

Deleting Rows, Columns, and Cells From Table 

When working with a table, you may need to delete unnecessary rows, columns, or separate 
cells.  

To delete rows, columns, or cells from a table:

1 Place the cursor in a row, a table, or a cell that you want to delete (you can delete only one 
element at a time) 

2 Click the following icons on the editor toolbar: 

  to delete the row  

  to delete the column  

  to delete the cell (the cells will be shifted to the left) 
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Merging Cells in a Table 

You can merge neighboring cells so that they form a single cell. Multiple cells can be merged 
either vertically or horizontally. 

To merge cells in a table:

1 Place the cursor in the cell you want to merge with other cells. 

2 On the toolbar, click  Merge cell to merge several cells into one. The Merge Cells dialog 
box opens. 

3 Enter the number of cells you want to merge and select the merging direction starting from 
the current cursor position. 

4 Click OK. 

 

Figure 14: Merge Cells dialog box 
 

Splitting Cells in a Table 

You can split a cell in a table into two equal cells or split a merged cell into the original number 
of rows and columns. 

To split a single cell into two equal cells (that was not merged before):

1 Place the cursor in the cell you want to split. 

2 On the toolbar, click  Split cell to split the current cell (where the cursor stands) into two 
equal cells. 

To split merged cells into rows or columns:

1 Place the cursor in the cell merged downwards. 

2 On the toolbar, click  Split Row or   Split Column to split the current cells into rows or 
columns. 

 

Dragging Tables to Another Location 

You can move a table to another position on the web page using a simple drag-and-drop 
operation. 

To move the table: 

1 Select a table using the mouse pointer. 
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2 Drag the table to the desired location and drop it.  

 

Figure 15: Moving a table 
 

Using SiteBuilder Modules 
This section describes how to use SiteBuilder modules, which extend the functionality of your 
HTML web site using different scripting languages. For example, if you want to have a forum, a 
guest book, or a feedback form on your web site, you can insert and configure them in a few 
clicks using the SiteBuilder editor. 

SiteBuilder has the following modules (the administrator or reseller determine which modules 
are available to you in accordance with the selected business plan): 

 Votes Editor 
 Blogger Editor 
 Counter 
 Feedback Forms Constructor 
 Forum Editor 
 Guestbook Editor 
 RSS Reader 
 Script Editor 
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General Rules for Working With Modules 

The sections below describe how to insert and configure each module. Here we list only the 
most general rules you need to follow when working with all SiteBuilder modules: 

 The module icons are located on the toolbar in the main editor window. To insert the 
desired module, simply click the toolbar icon. 

 

Figure 16: Module icons on the editor toolbar 

 You can add any number of modules on each page. 
 The modules cannot be viewed directly in the editor main window. You can see only white 

rectangles representing modules. To preview the modules as they will be displayed in 
browser windows, click the Preview web site button on the editor toolbar. Your web site will 
open in a new browser window with all elements displayed. 

 Modules can be resized in the main editor window. To change the size of a module, click on 
the module rectangle so that sizing handles appear (sizing handles are the small circles or 
squares that appear in the corners and on the sides of selected objects). Drag the sizing 
handle until the module is the size you want. 

 To delete a module from the page, click on the module in the main editor window and press 
the Delete key on the keyboard or the  icon on the editor toolbar. 

 

Using SiteBuilder Votes Editor 

Voting modules allow web site owners to conduct online polls and surveys, thus receiving 
valuable feedback from their customers. They can be used to collect information on the site 
audience, potential clients, products and services, and carry out marketing polls.  

Using the SiteBuilder Votes Editor, you can collect votes on different questions and display the 
results as dynamic graphical charts directly on the page. The SiteBuilder voting module tracks 
visitor uniqueness based on the single session principle, i.e. a visitor cannot vote several times 
in this poll within the same session (until he or she restarts the browser). 

To insert and set up the voting module:

1 On the editor toolbar, click the  Votes Editor icon. A white rectangle representing the 
module appears on the web page. 
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2 To configure voter settings, double-click the module rectangle on the web page. The Votes 
Editor dialog box opens. 

 

3 On the Properties tab of the Votes Editor dialog box, enter a question you want to ask your 
visitors about. 

4 Provide at least two answer options. For this, select the check boxes marked with red 
asterisks and type the answers. To provide more than two answers, click the Add Answer 
button to add an additional field.  

5 Open the Design tab to choose a design template for your voting module. Before this tab 
opens, you will be asked to save changes. 

 

Figure 17: Votes Editor. Design tab 

6 On the Design tab, select the design template and the design of bars that will graphically 
represent polling results on the page. 

7 Using the Multi select and Single select radio buttons, define whether users can select several 
answers or only one answer. 
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8 Select the Show borders check box to display borders around the voting module. Otherwise, 
clear this check box. 

9 Click the Preview tab to view how the module will look on your page. On the Preview tab, 
you can try to give an answer. 

10 Click Apply in the lower right corner of the tab to return to the editor main window. 

Note:

 In the editor main window, you can see only a rectangle representing the module. To 
preview the voting module, click the Preview web site button on the editor toolbar.  

 If you want, for example, to edit the question, answers to this question, or the graphical 
chart layout, double-click the rectangle representing the module in the editor main window. 
The Votes Editor will open, where you can change the module settings. 

 

Using Blogger Editor 

Blog's - Blog is short for weblog. A weblog is a web journal that is used as a publicly accessible 
personal diary or journal of an individual. Usually, blogs are frequently updated and reflect the 
personality of the author (a good example of blogs is the so-called live journals). Using the 
SiteBuilder wizard, you can insert a blog on your webpage. 

To insert and configure counter settings:

1 On the editor toolbar, click the  Blogger Editor icon. A rectangle representing the module 
appears on the web page. 

2 To configure blog settings, double-click the module rectangle on the web page. The Blogger 
Editor dialog box opens. 

3 On the User Options tab, enter the blog name as it will be used by a Blogger API-based 
application. 

4 In the Login field, enter the user login used to authorize a blog user to add, edit and remove 
posts either through the web interface or using Blogger API. 

5 In the Password field, specify the password and type it again in the Password confirmation 
field. Password and the user login are required for user identification. 

6 In the First name and Last name fields, enter your first and last names that will be transferred 
to the program that uses Blogger API. If the names are not specified, the program will not 
provide the first and last names of the blog owner. 

7 In the E-mail field, enter the e-mail that will be transferred to the program that uses Blogger 
API. If the e-mail is not specified, the program will not provide the e-mail of the blog 
owner. 

8 In the URL field, enter the URL that will be used to open the blog in the browser window 
through the program using Blogger API. 

9 Click the Preview tab to preview your blog as it will appear on your web site. Click the 
Login button on the Preview page and enter the login name and password you specified on 
the User Options tab. Here you can try to post new messages, edit them, and add your 
comments.  

10 Click Apply to save changes and return to the main editor window. 
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Inserting Counters Into Your Web Site 

You can insert a counter that will track and display the number of unique visitors at your web 
site during one day. 

To insert and configure counter settings:

1 On the editor toolbar, click the  Counter Editor icon. A rectangle representing the module 
appears on the web page. 

2 To configure counter settings, double-click the module rectangle on the web page. The 
Counter Editor dialog box opens. 

3 On the Properties tab, select the design of the counter and the starting number for the 
counter. 

4 Choose whether or not you want to reset counter to its initial position by selecting 
corresponding radio button (Yes or No) in the Reset counter radio group. 

5 To preview the counter as it will be displayed on your web page, open the Preview button. 

6 Click Apply to insert the counter and return to the main editor page. 

Note: For adding counter to your web site it is required to fill in the Counter start line and 
selecting wther or not you need to restart the counter. 

 

Figure 18: Counter 
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Constructing Feedback Forms 

Online feedback forms are used to create registration forms and send this information to the 
specified e-mail address. With the SiteBuilder Feedback Form Constructor, you can insert an 
online registration form on the web page to collect contact information about your visitors. 

To insert a feedback form on your web page:

1 On the editor toolbar, click the  Feedback Forms Constructor icon. A rectangle 
representing the module appears on the web page. 

2 To configure feedback form settings, double-click the module rectangle on the web page. 
The Feedback Forms Editor dialog box opens. 

3 On the Properties tab, enter the title for your form in the Feedback form name field. The title 
should correspond to the purpose of this form, for example, Contact Information. This field 
is mandatory. 

4 In the E-mail address field, enter the e-mail address to where the filled in forms will be sent. 
In the E-mail subject field, enter the subject for this e-mail message. 

5 In the Response text field, type the text that will be displayed on the page after a visitor fills 
in the form.  

 

6 On the Fields tab, select the fields that will be included in the feedback form. If you want to 
make a field mandatory for filling in, select the required field check box on the right of the 
corresponding field. 

7 Open the Preview tab to preview the feedback form as it will appear on your web site. Here 
you can try to fill in the form fields. After you submit the trial form, check that you have 
received the answers at the e-mail box you specified on the Properties tab. 

8 Click Apply to save the feedback form and return to the main editor window.  

If you want to edit the feedback form again, double click the feedback module rectangle in the 
main editor window to open the Feedback Forms Editor to make necessary changes. 
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Configuring Online Forums 

To improve the quality of your services and know the opinion of your customers and visitors on 
different matters, you can provide an online forum on your web page. Online forums are web-
based message boards where visitors can open new topics, post topic-relevant messages, and 
discuss a wide range of questions. Using the SiteBuilder Forum Editor, you can configure and 
set up an online forum in a few clicks. 

To insert and configure an online forum for your web site:

1 On the editor toolbar, click the  Forum Editor icon. A rectangle representing the module 
appears on the web page. 

2 To configure the forum, double-click the module rectangle on the web page. The Forum 
Editor dialog box opens. 

3 On the Design page, select the design template for your forum. To preview the selected 
template, open the Preview tab. 

 

Figure 19: Editing an online forum. Selecting the design 

4 On the Properties tab, do the following: 

 From the Message lifetime drop-down list, select the number of months during which 
messages will be stored in the forum. 

 In the Messages per page list, specify the number of messages displayed on each page of 
the forum. 

 From the Module width drop-down list, select the optimal width (in pixels) for your 
forum to fit better between page margins.  
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5 Click the Preview tab to preview your online forum as it will appear on your web site. Here 
you can try to create topics and submit answers.  

 

Figure 20: Previewing an online forum 

6 Click Apply to save the online forum and return to the main editor window.  

To change the design or edit forum settings, double click the forum module rectangle in the 
main editor window and make necessary changes using the Forum Editor. 
 

Creating Guestbooks 

On a guestbook page, your visitors will be able to leave their notes, messages, and comments. 
The main difference between guestbooks and online forums is that in forums, all messages are 
grouped in threads, or topics. In guestbooks, all messages are displayed in the order they were 
submitted. The SiteBuilder Guestbook Editor allows you to easily insert a guestbook on your 
HTML page. 

To insert a guestbook on the page:

1 On the editor toolbar, click the  Guestbook Editor icon. A white rectangle representing 
the module appears on the web page. 

2 To configure the forum, double-click the module rectangle on the web page. The Guestbook 
Editor dialog box opens. 

3 On the Design page, select the design template for your guestbook. To preview the selected 
template, open the Preview tab. 

4 On the Properties tab, do the following: 

 From the Message lifetime drop-down list, select the number of months during which 
messages will be stored in the guestbook. 

 In the Messages per page list, specify the number of messages displayed on each page of 
the guestbook. 
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 From the Module width drop-down list, select the optimal width (in pixels) for your 
guestbook to fit better on the page. 

5 Click the Preview tab to preview your guestbook as it will appear on your web site. Here you 
can try to send messages.  

 

Figure 21: Previewing a guestbook 

6 Click Apply to save the guestbook and return to the main editor window.  

To change the design or edit guestbook settings, double click the forum module rectangle in the 
main editor window and make the necessary changes using the Guestbook Editor. 
 

Importing News From RSS Channels 

RSS, which stands for Really Simple Syndication, allows webmasters to automatically load 
favorite news and information on private web sites from RSS news feeds (also called 
"channels"). Many well-known news communities and corporate web sites offer news headlines 
and article summaries in the form of news channels. RSS readers fetch the recent content from 
the RSS news feeds and display it on your web site. A visitor can preview the recent news 
content from your web site and will be redirected to the news page if  he/she wants to read the 
full story. The news from RSS channels will be updated automatically, required no interaction 
from your part.  

Using the RSS Reader integrated with SiteBuilder, you can easily add your favorite news from 
either well-known RSS news feeds or from your own RSS news channel to your web site. 

To add news from an RSS channel:

1 On the editor toolbar, click the  RSS Reader Editor icon. A rectangle representing the 
module appears on the web page. 

2 To select an RSS channel, double-click the module rectangle on the web page. The RSS 
Reader Editor dialog box opens. 

3 On the RSS Channels List tab, select the RSS channel from where you want to fetch the 
news. 
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Note: The RSS reader integrated with SiteBuilder allows you to select only one RSS 
channel. 

4 If you want to add news from an RSS channel that is not in the list, click the Own RSS 
Channel Subscription tab and enter the URL of this RSS channel. 

5 Return to the RSS Channels List tab and select the Own RSS channel radio button. 

6 On the Preview tab, you can preview the news fetched from the selected RSS channel as 
they will appear on your web site.  

7 Click Apply to save the settings and return to the main editor window.  

To change RSS channel settings, double click the RSS Reader editor rectangle in the main 
editor window and make the necessary changes. 

 

Figure 22: Selecting an RSS channel 
 

Using Script Editor 

Using the SiteBuilder Script Editor, you can add your own Java Script, HTML, and DHTML 
code to your web pages. 

Important: To protect the SiteBuilder server from possible security breaches, you cannot add 
the scripts that are executed on the server's side, for example, PHP, CGI, or ASP code.  

To insert HTML or JavaScript code on your web page: 

1 On the editor toolbar, click the  Script Editor icon. A white rectangle representing the 
module appears on the web page. 

2 To enter the script, double-click the module rectangle on the web page. The Script Editor 
dialog box opens. 

3 On the Script Text tab, type in the script. 

4 Click the Preview tab to preview the web page with the script you have just entered.  

5 Click Apply to save changes and return to the main editor window. 
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Editing Photo Gallery Pages 
Using SiteBuilder, you can add photo gallery pages to your web site, which are optimized for 
presentation of photographs (see the How To Add Pages (on page 16) section about adding 
photo gallery pages). 

To add photos to the photo gallery:

1 In the main editor window, navigate to the photo gallery page using the menu buttons of 
your web site.  

2 On the photo gallery page, double click the photo gallery module rectangle to open the 
Photo Gallery Editor. 

3 On the Photo Management tab, type the path to the graphic file you want to add to the photo 
gallery or click Browse to locate it. 

4  In the Image caption field, enter a caption for this picture.  

5 Click Add Image. The picture thumbnail and its caption appear in the list below the Add 
Image button. You can add any number of photographs to the photo gallery. 

 

Figure 23: Adding images to the photo gallery 

6 On the Template Selection tab, left-click the design template for your photo gallery.  

7 On the Preview tab, you can preview your photo gallery as it will appear on your web site.  

8 Click Apply to save the photo gallery and return to the main SiteBuilder editor window. 
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Notes:  

 To remove images from the list on the Photo Management tab, select the corresponding 
check box in the Delete column and click the Delete Image(s) button.  

 You can add new or delete unnecessary photographs as many time as you wish. To edit the 
photo gallery, double click the photo gallery module rectangle in the main editor window. 

 You can preview the photo gallery in two ways: on the Preview tab of the Photo Gallery 
Editor and using the Preview web site button in the main SiteBuilder editor window. 

 

Creating Your E-Shop 
Using the SiteBuilder E-shop editor, you can easily create, operate, and maintain your own 
professional-looking online store in less than an hour. To create a professional and profitable 
ecommerce store, you do not need any programming or web site design skills because all you do 
is to point and click.  

You, as the e-shop owner, can create categories of products, add products to the categories, and 
manage users who will be able to purchase the products online. Customers browse your e-shop, 
add products to their shopping carts, and submit their orders. They register at the store online so 
that they can later return to their shopping carts and continue shopping. Your ecommerce 
resource can be integrated with the PayPal payment processing system so that customers can 
pay for their purchases using their credit cards. If you do not want to accept credit card 
payments, the orders made through your online store will be saved in the E-shop Management 
System, from where you can view customers' contact information and handle orders. The 
sections below describe in detail how to create and manage a fully-functional web-based online 
store. 
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Adding E-Shop Page 

First, you need to add a page of the Eshop type to your web site. Although the general procedure 
for adding pages is described in the How To Add Pages (on page 16) section, read the 
instructions below on how to add E-shop pages. 

To add an e-shop page:

1 On the Pages tab of the SiteBuilder wizard, click Add New Page. 

 

Figure 24: Adding an online store page 

2 On the additional screen (in the figure above, it is shown in gray), select the Shop page from 
the Type drop-down list and enter the title for the new page in the Title field. 

3 Click OK to add an e-shop page to the web site structure. To move it to another place in the 
structure, use the Move Page Up, Move Page Down, Move Page to Upper Level, and Move Page 
to Lower Level buttons. 

After the e-shop page is added, you can start adding the products and configure the online store 
settings. To add the content to the e-store, in the main editor window navigate to the e-store 
page and double-click the white rectangle representing the e-shop module to open the e-shop 
editor. The sections below describe how to add the content and manage your online store in 
detail. 
 

Selecting Design and Configuring Settings 

After the e-shop page is added, you need to select the design and configure e-shop 
administration settings . 

To select the design and configure settings for your online store:

1 On the e-shop page in the main editor window, double click the e-shop module rectangle to 
open the Shop Editor. 
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2 On the Design tab, define the currency settings for your online store: 

 In the Monetary unit field, enter the currency used as a payment unit at your store. 

 Using the radio buttons below, select the location for the monetary unit symbol: before 
the price or after it. 

3 Select a graphical template for your e-shop: 

 In the upper part, select a template for the product category catalogue 

 Below, select a template for product lists 

 

Figure 25: Creating design for the e-store 

4 In the Product categories per page field, enter the number of categories displayed per page. 
The default value is 6 categories. 

5 In the Products per page field, specify the number of products displayed on e-shop pages. 

6 In the Category Image Preview Height and Category Image Preview Width fields, specify the 
height and width of the preview image for shopping categories (in pixels). The default 
height is 100 pixels and the default width is 70 pixels. 

7 In the Product Image Preview Height and Product Image Preview Width fields, enter the height 
and width of the preview image for products (in pixels). The default height is 100 pixels and 
the default width is 70 pixels. 

After you have set the design options, open the Mail Parameters tab to configure e-shop mail 
settings: 

1 On the Mail Parameters tab, specify settings of the e-mail notification sent to users after they 
have registered at your online store: 

 In the From E-mail Address field, enter the e-mail address from which the notification 
email will be sent. If you leave this field empty, the e-mail will be sent from the default 
address of the SiteBuilder server. 

 In the Sign Up E-mail Subject field, type the subject of this notification e-mail message. 

 In the Sign Up E-mail Message field, enter the text of the notification e-mail sent upon 
registration at your shop. 
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2 Specify settings of the e-mail sent to the customer if he/she has forgotten the password for 
the account: 

 In the Forget Password E-mail Subject field, type the subject of this e-mail message 

 In the Forget Password E-mail Message, enter the text of the e-mail message sent to the 
user in case he/she forgot his/her password 

3 Specify settings of the e-mail sent to the customer after he/she submitted the order:  

 In the Order E-mail Subject field, enter the subject of the e-mail notifying the user about 
the order 

 In the Order E-mail Message field, type the message text notifying the user about the 
order 

4 After this, go to the Categories tab to add categories of products to your online store. 
 

Adding Categories and Products 

To load your online store with goods, you first need to create categories. Then, add products and 
their pictures to the existing categories. 

To add categories:

1 In the Shop Editor, open the Categories tab. The list of categories is empty at the beginning. 
Click Add Category. 

2 In the Category Name field, enter the name of the category (for example, home appliances).  

3 In the Category Image field, enter the path to the image for this category or click Browse to 
locate it. You can add images of any size because SiteBuilder will automatically resize them 
to fit the maximum size specified on the Design tab. 

4 Click Apply. Add more categories in the same manner as described above. 

To add products to the categories:

1 Open the Products tab and click Add Product (unless you add at least one category, the 
Products tab is unavailable) 

2 On the next screen, specify the following information about a product: 

 From the Product Category drop-down list, select a category for the product (for 
example, home appliances). 

 In the Product Name field, enter the name of the product (for example, toaster). 

 In the Product Image field, enter the path to the image of this product or click Browse to 
locate it. You can add images of any size because SiteBuilder will automatically resize 
them to fit the maximum size specified on the Design tab. 

 In the Brief Product Description text box, enter a short description of the product that will 
be displayed on the Products Category page. 

 In Product Description text box, type a full description of the product displayed on the 
product page. 

 In the Price field, specify the product's price in the currency units you specified on the 
Settings tab. 

3 Click Apply to save changes. Add more products to the store following the procedure 
described above. 
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Integration With PayPal 

To accept payments online, you can integrate the PayPal payment processing system into your 
online store. Online shoppers will be able to pay for their purchases using credit cards directly 
from your web page. 

If you, as the store owner, want to accept credit card and bank account payments from shoppers, 
use the integrated PayPal payment system at your online store. For this, you should have a 
merchant account at PayPal (www.paypal.com). Therefore, register at PayPal. On the official 
PayPal web site, you can find more information about PayPal services for online store owners. 

To integrate your e-store with the PayPal payment system:

1 In the Shop Editor, open the PayPal tab where you should customize PayPal-related settings. 

2 In the PayPal E-mail field, enter the e-mail of your PayPal account (in PayPal, all accounts 
are attached to e-mails). 

3 From the PayPal currency of the payment drop-down list, select the currency unit for 
payments through PayPal. 

4 If you want to charge a fee for handling PayPal-based orders, in the PayPal Handling field, 
enter the fixed fee that will be charged for processing a single order. This fee does not 
depend on the number of goods in the shopping cart. The specified sum will be added to the 
total sum of the shopping cart. If no sum is entered, the fee for handling orders will not be 
charged. 

5 Specify the shipping rates for shipping goods purchased by customers: 

 If you want to charge a fixed shipping rate, in the PayPal Shipping field enter the fixed 
amount charged for shipping an order, regardless of the number and weight of purchased 
items. If you leave this field blank and specify the per-item shipping fee (see below), the 
shipping fee will be charged per item. If you leave this field blank and do not specify the 
per-item shipping fee as well, no shipping fee will be charged. 

 If you want to charge a fee for shipping every item in the shopping cart, in the PayPal 
Shipping Per Item field specify the amount charged for shipping a single item. The total 
shipping fee will be the specified per-item fee multiplied by the number of items in the 
shopping cart. 

 In the PayPal Tax field, specify the amount of taxes applied to the transaction, regardless 
of the buyer's location. The value in this field overrides other tax settings in your PayPal 
Profile. If you leave this field blank, the tax rates specified in your PayPal Profile will be 
applied. 

6 Click Apply. 

Note: The PayPal settings specified in the SiteBuilder Wizard override the respective settings in 
your PayPal Profile! Therefore, if you want to apply the Profile settings, leave the above fields 
blank. 
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Previewing and Managing Your Online Store 

Now you can preview your online store and submit a trial order to understand how your store 
works in the live context.  

1 Previewing your online store. Open the Preview tab and browse the categories and products 
at your online store.  

2 Adding items to your shopping cart. Imagine that you are an online shopper. Add items to 
your shopping cart by clicking the Add to cart button next to the product you want to 
purchase. Each time you click Add to cart the item is added to the shopping cart. 

3 Viewing your shopping cart (non-registered user). At any time during your shopping, you 
can view the contents of the shopping cart by clicking Your cart at the top of the shop page. 
In the shopping cart, you can change the quantity of selected items. Type the desired 
quantity in the Quantity field and click Update cart. The total sum of your purchase will be 
updated. To remove an item, select its check box in the Remove column and click Update 
cart. To remove all products from the cart, click Empty cart. 

4 Registering at the online store. When you finish with your shopping cart, click Shipping to 
provide customer details. Do not forget that now you are acting as an online shopper. If you 
have already visited this store and have an account, enter your user name login and 
password under For registered users. If you are doing this for the first time, under For 
unregistered users, provide your contact information, user login and password to login to 
the store. SiteBuilder will send the user login and password to the customer's e-mail address 
specified in the form. 

 Now you, as the store owner, can view the user details you have just provided on the 
Users tab. SiteBuilder collects the contact information of registered users and displays 
them on the Users tab. On this tab, you can add user accounts manually or delete them. 

5 Checking out your shopping cart (registered users) and submitting the order. After you 
have submitted your registration form, you will automatically log in to the store. Click 
Shipping again to check out your cart and submit the order. Click I agree and on the next 
screen, check the correctness of your personal information before you submit the order. 
Click I agree again. Your order is submitted. You will receive a confirmation order e-mail at 
the address specified in the user registration form. 
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If your online store is integrated with the PayPal payment processing system, after you click 
I agree for the first time, a new browser window will open at the PayPal web site. You, as a 
shopper, should log in to PayPal (if you have a PayPal user account) or specify your data, 
including the credit card number, e-mail, address etc. Your payment will be processed via 
the PayPal system. 

 

Figure 26: Checking out the shopping cart 

 Now you, as the store owner, can view the orders in a table on the Orders tab. The table 
lists a unique ID number, date of creation, date of the order update, status, and the sum 
of the order. To view the order details and change manually the status, click the ID 
number of the order. A new page will open. To change the order status, select the status 
from the Set status for this order drop-down box and click Update. To delete this order, 
click Delete. To return to the list of orders, click Back to order list.  
If your online store is not integrated with PayPal, you will need to contact your 
customers either by phone or e-mail and accept payments using other ways, such as 
cash, cheque, money order or mail payments. In this case, you will need to change the 
order status manually on the Order tab of the wizard. 

If you have integration with PayPal, all credit card payments will be processed via the 
PayPal service. After a payment is processed, the PayPal system will send an automatic 
payment verification and the order will be assigned the Paid status automatically. All 
you need to do is to check the status of orders on the Orders tab. 
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6 Click OK to return to the main SiteBuilder editor window. 
 

Advanced Editing 
The SiteBuilder WYSIWYG editor automatically converts the textual and tabular information 
on your web pages into the HTML code. HTML, which stands for HyperText Markup 
Language, is a standardized language for presenting information, graphics, and multimedia on 
the World Wide Web. Using the Advanced Editing feature, you can easily apply different styles 
and change properties of selected elements. 

At the bottom of the SiteBuilder editor window you can see a panel displaying the HTML 
structure of the line, on which your mouse cursor is now placed. 

 

Figure 27: Advanced editing of properties 

For example, if you place the mouse cursor in a table, the HTML code structure will contain the 
following tags, as shown in the figure above (for example, BODY, H2, TABLE, TBODY, TR). 
The tag where the cursor is now is shown in bold. The child tags of the active tag are enclosed 
in parenthesis.  

To edit the textual content inside a tag:  

1 Place your mouse cursor in the line you want to edit and click on the tag name in the 
advanced editing bar. 

2 Click the Advanced button in the lower right corner of the Advanced bar. 
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3 The Advanced tag properties dialog box opens. This dialog box opens for the following tags: 
P, TR,TD, P(NORMAL), H1, H2, H3,H4,H5,H6,ADDRESS, PRE(FORMATTED), 
A,OL,UL,LI,DIV,SPAN,FONT. In this dialog box, you can change the following 
properties: adjust padding properties (in the Padding section), set margins for the text body 
(in the Margin section), and select the color for text and background, and the color and style 
of borders. 

 

Figure 28: Advanced editing of properties 

4 Click OK. The changes will be immediately applied in the editor screen. 

For some tags, such as TABLE, TR (Table Row), TD (Table Data) A (Link), UL (Unordered 
List), OL (Ordered List), HR (Horizontal Rule) and IMG (Image), you can edit properties. The 
set of properties that you can edit is different for each of these tags. 

To edit properties:

1 Place your mouse cursor in the line you want to edit and click on the tag name in the 
advanced editing bar. 

2 Click the Properties button on the Advanced bar. The Tag Properties dialog box opens. 

3 You can edit the following properties for the tags: 
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 For TABLE (Table), you can adjust cell spacing, cell padding, table width and height, 
table and cell alignment, and define the style of borders. 

 

Figure 29: Editing TABLE tag properties 

 For TR (Table Row) and TD (Table Data) tags, you can the width and height of table 
cells and rows and alignment patterns. 

 For A (Link), you can change the link path, link text, target pages, decoration in the text. 

 For UL (Unordered List), you can change the style of bullets. 

 For OL (Ordered List), you can change the style of numbers in the list. 

 For HR (Horizontal Rule), you can adjust the width and height of the horizontal rule. 

 For IMG (Image), you can edit the image title and alternate text, image width and 
height, and alignment. 

4 To apply changes and close the Tag Properties dialog box, click OK. 
 

Providing site info 
One of the final stages of creating a web site is to provide information about your web site, or 
meta tags, which will be used by search engines to index your future web site. You can also set 
up a password to protect your web site from editing by unauthorized users.  
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Inserting Meta Tags Into HTML code 
Some search engines, such as Alta Vista, Excite, Lycos, Yahoo and other, use "meta tags" 
embedded in the HTML code in your web site to index web documents. Meta tags are inserted 
into the "head" area of your web pages. There are three most common types of meta tags: site 
title (TITLE tag), site description (META DESCRIPTION tag), and site keywords (META 
KEYWORDS tag). 

Though the use of meta tags does not guarantee your web page a top ranking on crawler-based 
search engines, it is a good way for web site owners to control how their web pages are 
described by some search engines. Meta tags are useful for additional web site promotion with 
some search engines. The SiteBuilder wizard's interface allows you to easily insert meta tags in 
the HTML code of your web site. 

To provide information about your web site:

1 Click the Extra tab in the main SiteBuilder window. 

2 Click Metatags in the navigation pane and provide information about your web site: 

 In the Site Title field, type the name of your web site that will be displayed in the 
window title bar of the browser window. This title bar is located at the upper left corner 
of the browser window. The site titles are important because they identify your page for 
users and search engines use titles as the primary identifier for listing pages in search 
results. Therefore, the title should be short, unique, and descriptive.  

 In the Site Keywords field, enter several keywords or phrases separated with a comma, 
which describe your web site best. Some search engines that support keyword searching 
will index your site using the keywords you provide.  

 In the Site Description field, type a short description of your page displayed by search 
engines when they hit your web site. Keep your description short and informative (25-30 
words) or most of your description will be truncated. It is worthwhile to use the meta 
description tag for your pages, because it gives you some control with various crawlers. 

3 Click Apply. 
 

Setting Up Password 
You can specify a password to prevent unauthorized users from editing your web site. Use this 
password to log in to the SiteBuilder wizard next time when you are editing your web site.  

To set up a password:

1 On the Extra tab, click Password in the navigation pane. 

2 In the Site password field, enter the password for your web site to protect it from editing. 
This password will be used to log into the SiteBuilder wizard. 

3 In the Site password confirmation field, confirm the password specified above. 

4 Click Apply. 
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C H A P T E R  4  

Features For Regular Sites 

Finally, your web site is almost complete and you are ready to share it with Internet users by 
publishing it on a web server.  

When you are creating your web site in the SiteBuilder wizard for the first time, all site files are 
saved in a temporary storage on the SiteBuilder server. From this point of web site building, all 
web sites are divided into trial web sites and regular web sites.   

 A trial web site is a site with limited functionality. Trial sites cannot be published. They are 
created by users who use SiteBuilder for the first time. 

 A regular web site is a site that can be published. Moreover, two additional features, SE 
Submission and Statistics, are available only for regular sites.To update a site from a trial to 
regular, follow the wizard's instructions on the Publish tab or contact the SiteBuilder 
administrator. 

This section describes the two modules, SE Submission and Statistics, that are available only for 
regular sites and are not available for trial sites. 
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Submitting Your Web Site Into Search 
Engines 

Using SiteBuilder SE Submission module, you can easily submit your site information to 
popular search engines.  

To submit your site information: 

1 On the Extra tab of the SiteBuilder wizard, click the SE Submission button in the navigation 
pane. 

2 In the Site URL field, enter the URL of your web site, including the http:// prefix. 

3 In the Site E-mail field, enter the e-mail of your web site. 

4 Select the check boxes corresponding to the search engines to which you want to submit the 
web site information. 
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5 Click Submit. The information about your web site will be submitted to the selected search 
engines. 

 

Viewing Statistics 
The SiteBuilder Statistics module allows web site owners to view statistic information and track 
user activities on your web site. The module generates more than twenty different reports on 
various categories of statistic data. Using this information, web site owners can track visitors 
from a statistical point of view, which gives them an ability to increase the effectiveness of 
marketing campaigns and improve business processes. For your convenience, the SiteBuilder 
Statistics module displays graphical representations of statistical data, such as linear charts, 
tables, and pie charts.   

Note: This module is available only for regular sites if it is included in the current business plan.  

To view the statistics:

1 On the Extra tab of the SiteBuilder wizard, click the Statistics button in the navigation pane. 

2 Using the drop-down lists in the lower right corner of the Statistics page, select the reporting 
period.  
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3 Using the links on the right side, select the statistic categories you would like to view. Click 
a link to open a report on the selected statistic category, which is organized as tables, linear 
diagrams, or pie charts.  

 

Figure 30: Statistics Screen 

4 Attendance statistics includes the following reports: 

 Hits - total number of hits on the pages of your web site during the reporting period.  

 Hosts - number of unique users (with unique IP addresses) that visited your web site 
during the reporting period.  

 Sessions - number of hits on the pages of your web site if the time elapsed between the 
two hits exceeded 15 minutes (i.e., the duration of an average user session is 15 
minutes). 

These reports include hystograms, where the y axis is the number of hits (hosts or sessions) 
and the x axis is hours. Below, you can see a table displaying the number of visitors (i.e., 
hits on web pages and sessions length). Using this information, you can define "peak times" 
when your web site was visited by the largest number of visitors. 

5 Statistics on pages includes the following reports: 

 Popular pages - list of most popular pages of your web site. The table displays the page 
name, number of hits on this page, and the percentage of hits on this page of the total 
number of hits on your web site. 

 Entry points - pages on which users enter your web site, i.e. the first pages in user 
sessions. This indicates if users mainly enter through the home page or whether they 
access your web site from other pages, possibly through their bookmarks or through 
external incoming links from other sites.  
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 Exit points - pages where users leave your web site, i.e. the last pages in users' paths.  

 Visit length - time (in minutes) users spend on your web site. This report includes a pie 
chart and a table, which displays the number of minutes users spend on your web site. 

 Depth of site visit - number of pages users visit during one session.   

6 Statistics on user systems includes the following reports presented as pie charts:  

 Operating systems - types of operating systems running on user computers 

 Browsers - browsers used to view your web site 

 Screen resolutions - screen resolutions set up on the computers of your visitors 

 Color depths - color quality set up on visitors computers 

 Cookies usage - percentage of visitors who use/do not save cookies 

 Javascript usage - percentage of visitors who have/do not have Javascript support 
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C H A P T E R  5  

How to Publish Your Web Site 

To publish a web site means to copy the web page files to a special directory on a web server. 

To publish a web site: 

1 Click the Publish tab in the SiteBuilder window. 

2 You will see a link to the temporary storage of your web site files. Your web site is now 
saved as a trial site in a temporary storage directory on the SiteBuilder server. Follow the 
instructions on this tab on how to publish your web site. Generally, the procedure is as 
follows: 

3 On the Publish tab, you will see an automatically generated site identifier. Using this link to 
the trial site, which might look like 
http://site_identifier.sitebuilder.hosting_provider.com, you can 
later return to your web site, edit it and publish (about editing your web site, see the How to 
Edit Your Web Site (on page 56) chapter). The password for editing your web site is the one 
you have set up on the Extra tab (Password button in the navigation pane). We recommend 
that you change the site identifier to some name you can easily remember (click Change My 
Site Identity). To send your site identifier and password at the e-mail address, click the Send 
site information to your e-mail button.  

 Purchase hosting services using the link provided on the Publish page. After you 
purchase hosting services from your hosting provider, you will receive a domain name. 
Tell the SiteBuilder administrator the domain name where your web site will be hosted. 
The SiteBuilder administrator will enter this domain name in the publishing properties 
for your web site in the SiteBuilder administrator panel.  

 Enter the link to your trial site in the address bar of the browser window. Enter your 
password in the Password field. Your web site will open in the browser window. Click 
Edit at the top of the page. The SiteBuilder wizard will open. You can either edit   the 
content of your web site or go directly to the Publish step. Click Publish web site. The 
content of your web site will be transferred to the server where your web site is hosted. 
After publication, your web site will be available on the Internet. 

Attention! Be careful when publishing your web site because your old files will be 
overwritten with the new files during the publishing process. 
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C H A P T E R  6  

How to Edit Your Web Site 

It is critical to keep the information on your web site up-to-date. You can add news, edit the 
content, and provide information on new products and services. If your web site is updated on a 
regular basis, Internet surfers will see that you care about your image on the world wide web. 
Using the SiteBuilder wizard, you will be able to edit your web pages and add new content. 

You can easily add new pages, edit the old content, and publish your web site at any time using 
the SiteBuilder wizard. 

To edit your web site through the SiteBuilder wizard: 

1 Open your web site in the SiteBuilder wizard: 

 You can launch SiteBuilder from the web site of your hosting provider and enter your 
site identifier and the password in the authorization screen. 

OR 

 Enter the URL to your web site in the address bar of your browser and enter the 
password in the Password field. 

2 Your web site will open. At the top of the page, click the Edit button. The SiteBuilder editor 
will open in the new browser window. 

3 Edit your web site: you can change the current design (Design tab), add new pages (Pages 
tab), edit the content, insert new modules and pictures (Edit tab), etc. 

4 Open the Publish tab. Click the Publish web site button. The new content will be transferred 
to the location where your web site is hosted. After the publishing operation is completed, 
the updated web site will be available on the Internet. 

Attention! Be careful when publishing your web site because your old files will be 
overwritten with the new files during the publishing process. 
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Glossary 

BROWSER  

A browser is a software application that lets you access information on the Internet. Browsers 
can read HTML and send HTTP or FTP requests for services on the Internet. Browsers are 
usually associated with the World Wide Web portion of the Internet. 

 

FTP  

FTP, or File Transfer Protocol, is a method used to transfer files to (upload) and from 
(download) a remote server. You can use the FTP command to: 

 Copy a file from the Internet to your PC 
 Move a file from your PC to the Internet 
 Rename an existing file 
 Delete a file 
 Update an existing file with more recent data 

 

HOST  

In a network, a host is usually a computer that stores software applications and data that may be 
accessed or retrieved by other users. But a host can be any addressable device on the network, 
not just a computer. The host provides services to other computers or users. An Internet Service 
Provider may also be referred to as a Web hosting company. 

 

HTML  

HTML, or HyperText Markup Language, is a standardized language for presenting information, 
graphics, and multimedia on the World Wide Web. HTML consists of hundreds of codes, tags, 
and symbols that define the type of information and how it should be displayed in a browser. 
HTML is universally understood on a wide variety of platforms. 

 

IP ADDRESS  

An IP address (Internet Protocol address) is an internal number that identifies a host on the 
Internet or a network. IP numbers are invisible to end users, replaced in your user interface by 
the more familiar domain names and URLs. 
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URL  

A URL is a Uniform Resource Locator used to identify an organization or domain on the 
Internet. URLs are standardized names that are typically found on the World Wide Web portion 
of the Internet. URL addresses identify domains on the network. 
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